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1 Welcome to StarOffice 8!
This document provides an overview of the new and enhanced features and key changes introduced in 
StarOffice 8 software. When designing this new version, the team paid close attention to feedback from 
existing StarOffice users around the globe.  All users will benefit from the many usability enhancements, 
increased Microsoft Office interoperability, easy multi-language install and a productivity features such 
as a redesigned database and presentation module (Impress).    

Small business owners and consumers will enjoy the ease of working with powerful productivity tools in 
a fully integrated environment and the ability to jump start their projects with professionally designed 
templates. Enterprise and government users will benefit from XForms support, increased document secu­
rity, the JavaTM Desktop System Configuration Manager that allows for easy install and administration, 
Accessibility (assistive technology) support and increased XML filter functionality that extends XML 
support for Math and Web (through Writer, the word processor) components. Developers and Indepen­
dent Software Vendors (ISVs) will benefit from enhancements to the Software Development Kit (SDK), 
new scripting languages, and a new file format that follows the OASIS standard for open file formats in 
office productivity.  Educators and students will appreciate the multilingual writing aids, improved online 
help, and advanced graphics capabilities of this award winning office suite.

Overview Of StarOffice Software: 
This section describes the main features of StarOffice: 

● A significant cost savings over alternative office suites. 

● Comprehensive office productivity – StarOffice 8 software provides word processing, spreadsheet, 
presentation software, drawing, database and HTML capabilities.

● Multi-platform – StarOffice 8 software runs on Microsoft Windows, Linux, and the SolarisTM Oper­
ating System (SPARC® and x86).

● Microsoft Office compatibility – read, edit and save to MS Word, MS Excel and MS PowerPoint file 
formats.

● Support for third party applications like PDF, FLASH, WordPerfect, Lotus 1-2-3, PDAs and Internet 
Explorer.

● Easy to learn and use – familiar user interface, industry standard menus, icons, dialog boxes, layout.

● Open – source code can be found at www.openoffice.org and is available for download as source or 
binaries.

● Accessibility support – through third party assistive technology tools, StarOffice (along with online 
help and user documentation) can be used by people requiring large fonts, screen readers, alternative 
input devices etc.

● Complete support of open, XML file formats - StarOffice default file format is XML and full details 
of the file format can be found at www.openoffice.org.

5

CHAPTER  1



Key Benefits Of StarOffice 8

Increased Usability 
We have made StarOffice 8 even easier to use and learn for users of other office suites. Major enhance­
ments have been made to toolbars, menus, presentation software, user interface, data pilot (pivot tables) 
and headers/footers. There is also a format paintbrush tool for easy manipulation of styles and formatting 
and a mail merge wizard to easily create and send letters. Other areas of usability that have been 
improved include bullets, text and table selection, spellcheck, word count, spreadsheet cell formatting, 
email attachments and online Help. 

Improved Microsoft Office Compatibility
StarOffice provides the best Microsoft Office import and export filters available today to facilitate the 
exchange of documents (word processing, spreadsheet, presentations) with Microsoft Office users. 
StarOffice 8 significantly improves the compatibility between StarOffice files and Microsoft Office files 
and MS Office users will find it even easier to learn and use StarOffice. StarOffice 8 software supports 
MS PowerPoint AutoShapes, password-protected MS Word and MS Excel files, WordML and spread­
sheetML files, provides 64,000 rows in Calc to import large MS Excel spreadsheets; enables better im­
port and export of tables, headers and footers, formatting, complex Excel formulas, and text frames.

Increased Interoperability With Other, Popular Third Party Applications
StarOffice 8 also features improved PDF export (supporting hyperlinks and table of contents), import of 
WordPerfect documents, XML filter functionality for formula and HTML and Lotus 1-2-3 files. StarOf­
fice 8 introduces XForms support, enabling higher levels of interoperability with other vendors who also 
support this standard

Installation And Administration 
StarOffice 8 includes the Java Desktop System Configuration Manager. This central configuration tool 
helps manage StarOffice users user settings, such as profiles, policies, security and authentication, access 
controls.

Note that the Configuration Manager is available only with the StarOffice 8 Beta Enterprise Edition 
which is available through Sun sales and partners. For more information please visit this site: 
www.sun.com/sales

Installation is also easier with the multi-language installation feature, which allows users to select a lan­
guage to install without having to re-install specific language packs and support for the native installation 
types provided by the user's operating system. 

New Database Engine And Front-end Tool 
StarOffice 8 has totally re-designed its database front-end tool (StarOffice Base) which makes it much 
easier to create forms, queries and reports. StarOffice Base supports major database types and connec­
tions like mySQL, ADO, Oracle, ODBD, JDBC and works similarly to those databases. StarOffice 8 also 
introduces the HSQLDB database engine in addition to Adabas D. 

Seamless Integration With Native Operating System And Desktop  
StarOffice 8 seamlessly integrates itself into the desktop of the native operating system – whether it is the 
Solaris Operating System, Linux, or Microsoft Windows. StarOffice uses the objects, themes, settings 
etc. of the user's desktop and behaves like a native application.
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New XML File Format, Compatible With Previous StarOffice File 
Formats 
StarOffice 8 adopts the OASIS (Organization for the Advancement of Structured information Standards, 
a standards setting body) OpenDocument format. This further increases the interoperability of StarOffice 
as files can be exchanged with any application that also uses the OASIS XML file format. The new file 
formats will have .odx extensions where 'x' is the application (example: ods for the Calc 
spreadsheet).Note that StarOffice 8 is backward compatible, allowing users to load and edit documents 
created in StarOffice 7 or earlier versions. 

More Developer Features And Tools 
StarOffice can be customized and extended with a Software Development Kit (SDK). The SDK provides 
API concepts with descriptions, UNO component model and API usage within different application 
areas, and numerous examples using JavaTM, C++, Basic and OLE. 

Developers who want to write additional components, modify the StarOffice user interface, or otherwise 
extend the StarOffice software functionality can download the StarOffice SDK or the Office Develop­
ment Kit (ODK) at http://udk.openoffice.org/udk_package.html . The ODK source is available at 
OpenOffice.org (www.openoffice.org).

Chapter 1   Welcome to StarOffice 8!  7

http://www.openoffice.org/
http://udk.openoffice.org/udk_package.html


8   StarOffice 8 Guide to New Features



2 Usability Features
The usability enhancements in StarOffice 8 make StarOffice much easier to learn and use. The important 
areas that have received significant usability enhancements are:

● New toolbars

● Re-designed menus 

● Formatting and styles

● Mail merges

● Database

● Tables

● DataPilot (similar to MS Excel Pivot Tables) 

● Forms including XForms support and form controls 

● Headers and footers

● Look and feel of Impress

● Multimedia support  

● Multi-pane views in Impress 

● Seamless integration into native desktop and operating systems

● Office-related terminology

● Online Help 

General usability features that affect all applications will be described followed by usability features for 
each, specific application (Writer, Calc, Impress, Base).

General Usability Features

New Toolbar Concept And Design
StarOffice toolbars have been completely revised. They retain their context-sensitive behavior, but ini­
tially display only carefully selected default tools. 

Toolbars will appear as appropriate to the document or work at hand. Use the View – Toolbars menu to 
display additional toolbars.

You can also click the arrow icon located at the end of each toolbar to open a menu which provides the 
following options: Visible Buttons, Customize Toolbar, Dock Toolbar, Lock Toolbar Position, Dock All 
Toolbars.
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New File Format Names And Extensions
StarOffice 8 and OpenOffice.org 2.0 use the new OASIS (Organization for the Advancement of Struc­
tured Information Standards) OpenDocument XML (eXtensible Markup Language) file format as a 
default.  Support of this format has been announced by KOffice and a number of other products.

● Writer
 OpenDocument Text [.odt]
 OpenDocument Text Template [.ott]
 OpenDocument Master Document [.odm]

● Calc
OpenDocument Spreadsheet [.ods]
OpenDocument Spreadsheet Template [.ots]

● Draw
OpenDocument Drawing [.odg]
OpenDocument Drawing Template [.otg]

● Impress
OpenDocument Presentation [.odp]
OpenDocument Presentation Template [.otp]

● Math
OpenDocument Formula [.odf]

● HTML Template
HTML Document Template [.oth]
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Enhanced PDF Export
The PDF export functionality offers improved graphics output. The user has now the ability to use loss­
less compression or to set the quality level for exported images. 

The PDF export also supports:

● Hyperlinks
● Table of contents
● Document outline (for easy document navigation)
● Document notes
● PDF controls
● Tagged PDF (for Writer only)

Native Desktop Theme Integration (Native Widget Rendering)
To enhance integration of StarOffice with the underlying desktop, all user interface elements (such as 
buttons and scrollbars) have the same look as those used in other "native" applications for that desktop . 
StarOffice dynamically updates its appearance when a desktop theme or color is changed.

Native system theme integration will be available for Gnome (version 2.4 or higher) and Microsoft 
Windows (XP and newer) desktop environments. On Windows XP the "Windows XP Style" must be 
chosen under Settings->Control Panel->Display->Appearance to achieve the correct look.

Systems that do not support themes (e.g., Windows 98/ME/2000, CDE) do not display the improvements 
noted above. 
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More Feature Highlights:
Feature Benefit How to Access

XForms Support StarOffice is able to create and edit XForms 
compatible forms. XForms is an international 
W3C standard for the next generation of forms 
for the Web

XForms can do everything that HTML Forms 
can, and offer the following advantages: 

• Richer user interface to meet the needs of 
business, consumer and device control 
applications 

• Decoupled data, logic and presentation

• Improved internationalization

• Support for structured form data

• Advanced forms logic

• Multiple forms per page, and pages per 
form

• Suspend and Resume support

• Seamless integration with other XML tag 
sets, etc.

More information about XForms can be found 
on w3.org: http://www.w3.org/MarkUp/Forms/ 

Choose File – New – XML Form 
document

Increased 
document security 
through digital 
signatures

Digital signatures offer secure protection of 
document content. They offer reliable 
authentication of the author of a 
document/macros as well as assurance that a 
document has not been altered since it was 
digitally signed.  Digital signatures are also 
used to make security decisions, such as 
whether or not to run a macro.

Choose File – Digital Signatures 
to open the dialog. 

When a signed document is 
loaded, StarOffice shows a little 
red seal icon in the status bar at 
the bottom of the document 
window. Right-click the icon on 
the status bar to open the context 
menu, where you can also find 
the menu entry Digital Signatures. 
This can be done for the 
document content and for the 
macros independently

New file 
thumbnails for 
preview in file 
explorer

The file system explorer now displays a 
thumbnail preview of a StarOffice file. 

The standard file system explorer 
on Gnome (Nautilus) and 
Windows (Explorer) support a 
thumbnail view mode in which a 
small preview of the respective 
file system object will be 
displayed if available. 

Drag and drop 
selections to 
create styles 

You can now drag and drop a text selection 
into the Styles and Formatting window to 
create a new or user-defined paragraph style 
or character style (soft formatting).

Open the Stylists and drag the 
selected into the 'Styles and 
Formatting' window.

Improved 
AutoRecovery of 
documents

The Error Reporting Tool and the document 
recovery features are now combined into one 
process. If StarOffice crashes, the documents 
will be saved and a message informs the user 
that the recovery is taking place. After that an 
error report can be sent.

StarOffice will start automatically 
after a crash
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Feature Benefit How to Access

State name of 
office module in 
window title 

Instead of showing the file name or the title (if 
available) and the software name on the 
window title bar, now the file name plus the 
office component name (e.g. Writer, Calc, 
Impress, etc.) will be displayed. 

This text is on the title bar at top 
of the document window, above 
the menu bar.

Modularized 
Options 

The names of the various options pages now 
have names corresponding to the names of the 
StarOffice modules, such as Writer, Calc, etc. 
so users can more easily find the section they 
need. 

The Options found under Tools now also 
feature context sensitive sections. The user will 
see only those sections those that make sense 
in the given context of an active module. 

Choose Tools – Options

Added Keyboard 
Support for 
Assigning Styles 

You can now faster assign styles (e.g. 
paragraph, page, frame, character styles) 
using only the keyboard. This is especially 
important for users who can only work with a 
keyboard. A user can also quickly create easy 
to use shortcuts. 

Choose Tools – Customize – 
Keyboard 

A set of predefined shortcuts for 
paragraph styles is provided for 
StarOffice Writer.

Easy to customize 
menus and 
toolbars

Menus and toolbars can be easily customized. 
In addition to the new tab page in the 
Customize dialog, toolbars are now also 
customizable using drag & drop. Moving, 
removing and duplicating a tool (icon) is fast 
and easy. 

Choose Tools – Customize – 
Menus or Toolbars

More conformance 
with industry-
standard 
terminology

Some terms have been changed to be conform 
to industry-standard terminology. This will help 
to make these features more familiar to users. 
Some examples are:

● “AutoPilot” has been changed to “Wizard”

● “Stylist” has been changed to “Styles and 
Formatting”

● “Help Tips” has been changed to “What's 
This?”

Choose, for example, File – 
Wizards, Format – Styles and 
Formatting, Help – What's This?

Improved access 
to recently-used 
file list 

The File menu gives access to recently used 
StarOffice documents. This list is extended to 
10 items. It is also a sub menu in order to 
improve the usability of the File menu.

Choose File – Recent Documents

Search within Help 
pages enabled

Search functionality within pages in the 
StarOffice Help has been implemented. 

Open StarOffice Help from the 
main menu bar

More “How to” 
information in Help

Straightforward how to information to perform 
tasks in application. Such as creating table of 
contents, turning document into a template, 
adding page numbers in spreadsheet, etc.

Choose Help – StarOffice Help 
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Feature Benefit How to Access

MozillaTM/
NetscapeTM Plug-in

Viewing of StarOffice and MS Office 
documents in Mozilla/Netscape enabled.

The plug-in needs a version of Mozilla 1.x, 
Netscape 6.x, or Netscape 7.x installed on your 
system.

Choose Tools – Options – 
Internet – Mozilla Plug-in

Windows Explorer 
Infotips for 
StarOffice 
document

Infotips are now available for StarOffice 
documents viewed in the Microsoft Windows 
Explorer. Infotip handler are small ToolTip 
windows that show information about a file. 

The Windows Explorer shows 
such infotips if you point the 
mouse over a file for a few 
seconds.

Easier 
configuration for 
making 
e-mail 
attachments

Open your e-mail composer window with the 
active document directly attached. The task of 
configuring the email client has been 
simplified. 

Choose Tools – Options – 
Internet – Email

Start module is 
now optional

The Start Module – Module that does not show 
a specific type of document – becomes an 
optional module. A configuration setting is 
used to disable the Start Module if required for 
a site installation.

Choose Tools – Customize (In the 
Start module)

StarOffice Writer
StarOffice Writer provides features for both the novice and the advanced user.  By using one of the many 
included templates, beginners can quickly create anything from a professional letter to a gift certificate, 
resume or business invoice. Power users will find much to like as well, from the Stylist (now called 
Format Styles)  to the new mail merge wizard, which will enable easy creation of mail merges. 

Nested Tables
StarOffice 8 offers more flexibility in table creations. You can insert a table into a table cell. (This fea­
ture also improves the import/export of Microsoft Word documents, which can contain nested tables.)

How to access:  place your cursor in the desired cell of a table. Choose Insert – Table (or Table – Insert – 
Table).
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New Mail Merge Wizard
A new mail merge wizard makes sending form letters much easier than in previous versions of StarOf­
fice, whether you print them or send them out via e-mail.

Format Paintbrush
StarOffice has a new tool to ease copy and paste styles (formatting). It is called the Format Paint­
brush and directly transfers all formatting from text and objects to new targets. Choose the Format 
Paintbrush icon in the main toolbar. 

More Feature Highlights:
Feature Benefit How to Access

New Table menu A Table entry in the menu bar allows easier table 
handling.

Choose Tables in menu bar

Multipage cells in 
tables

Tables allow a page break within cell/row. Choose Tables – Table 
Properties – Text Flow – Break

WordPerfect 
document import

You can now open WordPerfect 4/5/6/7/8/9/10/11 
documents in StarOffice. 

File Open will automatically 
convert a WordPerfect file upon 
opening the file.

XML input/output 
filters 

The XML Filter functionality is now also available 
for HTML and formula documents. The 
functionality was introduced for Writer, Calc and 
Impress with StarOffice 7 and allows users to use 
the XSLT Template technology to build 
import/export filters. Moreover, all XML Filters 
now support both, the StarOffice 7 and and the 
new OASIS OpenDocument formats.

Choose Tools – XML Filter 
Settings.
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Feature Benefit How to Access

Improved 
spellcheck dialog

The new non-modal spelling dialog shows a 
spelled word in the context of a complete 
sentence. This context helps the user to decide 
whether a highlighted word is incorrect or only 
unknown. 

Furthermore the user can use the new undo 
functionality to undo changes within the spelling 
dialog without needing to return to the document.

Choose Tools – Spellcheck

Enhanced HTML 
export to produce 
"XHTML 1.0 
Strict"

Exporting HTML now produces well-formed, valid 
'XHTML 1.0 Strict' output.

Save in HTML

Word count in 
selections

StarOffice 8 can now provide a word count for a 
highlighted selection within a document.

Select the part of text in which 
you want to count the words. On 
the Tools menu, choose Word 
Count.

New vertical text 
direction in 
Tables

A new direction attribute for table cells has been 
introduced to allow the user to set the text 
direction for table cells so it can be different from 
the direction of the table environment. 

Select one or more cells in a 
table, then from the context 
menu choose Table – Text Flow 
– Text direction

Edit height of row 
in table with 
mouse

Now it's also possible to change horizontal lines 
using the mouse to adjust row height. 

Move mouse over a horizontal 
line in a table and drag and drop 
the line.

Enhanced 
selection of text 
and tables 

Select whole sentences or paragraphs quickly 
and easily with left mouse-clicks. (Multi-selection 
using the CTRL key is also possible for this type 
of selection.)

Also the selection in tables has improved. You 
can now select a whole table row or column by 
just clicking left of the table row or above the 
column. 

Triple-click the left mouse button 
anywhere in a sentence to 
select the whole sentence; 
quadruple-click to select the 
paragraph. (Double-clicking on a 
word still selects the word as in 
StarOffice 7) 

Insert bullets and 
numbering in 
several table 
cells with one 
mouse-click

Easily convert the content of several cells to 
bulleted or numbered lists with one mouse-click. 

Select one or more cells in a 
table. Click the Bullets On/Off 
icon or the Numbering On/Off 
icon from the Formatting toolbar.
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Feature Benefit How to Access

Shortcut for Edit - 
Paste Special

Perform Edit – Paste Special faster by using the 
keyboard rather than the menu. 

Shift+Ctrl+V

Hidden Text 
Attribute 

Easily hide parts of your text. Choose Format – Character – 
Font Effects – Hidden.

Ctrl + Up/Down 
accelerators 
added to move 
paragraphs 

Now Ctrl + Key Up/Down move a paragraph up or 
down, in addition to Ctrl+Alt+Key Up/Down. 

Use Ctrl+Alt+Key Up/Down 
move a paragraph

Automatically 
resize text frames 
width

Text frames can automatically resize as you type, 
a feature unique to StarOffice.

Choose Insert – Frame – Width 
Automatic

Better object 
positioning with 
'Follow text flow' 
option

The usability for positioning objects in text has 
been enhanced. The new option 'Follow text flow' 
has been introduced for text frames 

Specification of new option 'Follow text flow' for 
Writer fly frames that are anchored to paragraph 
or to character to control, if they have to follow the 
text flow or can leave their layout environment.  

If option 'Follow text flow' is activated, the Writer 
fly frame has to follow the text flow. If necessary 
the fly frame is positioned on the next page.

If option 'Follow text flow' is deactivated the Writer 
fly frame doesn't follow the text flow and can 
leave their layout environment.

After you have inserted a frame 
(Insert – Frame), choose Format 
– Frame – Type, see check box 
at the bottom.

Default tab stop 
position changed 
in tables of 
illustrations, 
tables of figures

The default tab stop positions in tables of 
illustrations, tables or figures, etc. have been 
changed. The tab stop is now aligned right and 
has a dot as fill character. This feature makes the 
behavior the same as in tables of contents (TOC). 

Chose Insert – Index and Tables

Bibliography 
database menus 
now customizable

You can now customize the bibliography 
database menus and shortcut keys via the Tools 
menu. 

Chose Tools – Bibliography 
Database – Tools – Customize 

StarOffice Calc
The StarOffice Calc spreadsheet allows you to calculate, analyze, share and visually communicate your 
data quickly and easily. You’ll find features like the Scenario Manager (for what if analysis), flexible cell 
formatting, natural language formulas (use words like “capital + interest”), Data Pilot (track and summa­
rize data in a cross-tabulated table) and built in templates (e.g. automatic currency exchange lookup). 
StarOffice 8 adds enhanced sorting options, more robust data import capability, easier printing, longer 
string length capability, more powerful matrix arrays and many new functions to improve MS Excel 
compatibility.

Row Limit Increased To 65536 Rows Per Sheet
The maximum number of rows in a StarOffice Calc spreadsheet has been increased to 65536 – the same 
as in Microsoft Excel spreadsheets. This number will be further increased in future releases.

Enhanced DataPilot
(DataPilot corresponds to Pivot Tables in Microsoft Excel). The DataPilot has been extended with the 
following functions:
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● DataPilot tables can now include page fields. 

● Result values can be shown in relation to results from other items. 

● Field items can be sorted by their names or result values.

● Items can be hidden manually, or automatically using their result values. 

● Tabular or outline layout mode can be selected for each field. 

● Items can be grouped together manually, by value ranges, or by date parts. 

● The “Show details” function can add fields to a DataPilot table (“drill down”). 

How to access: Choose Data – DataPilot. The “Layout” section of the DataPilot dialog has a new orienta­
tion area “Page” in addition to the existing “Column”, “Row” and “Data” areas. A “More>>” button has 
been added to the Data Value dialog allowing you to select the type of display for each field. An 
"Options" button has been added to the column/row/page field dialog to select the new options. To group 
items, select the item names in the output table and choose Data – Outline – Group. For "Show details", 
double click on an item name, or choose Data – Outline – Hide Details or Show Details.

Enhanced Header/Footer Dialog
You can now choose from a predefined set of headers and footers. This feature reflects how Microsoft 
Excel handles headers and footers. 

How to access: Choose Edit – Headers & Footers

More Feature Highlights:
Feature Benefit How to Access

Enhanced number 
recognition 

Number input into a cell no longer overwrites user-
defined number formats. 

Further more the number formatter now also 
recognizes the following date/time input (ISO 8601 
conform): yyyy-mm-dd, yyyy-mm-dd, HH:MM, yyyy-
mm-dd, HH:MM:SS, yyyy-mm-ddTHH:MM, yyyy-mm-
ddTHH:MM:SS 

Not Applicable – happens 
automatically

Create named cell 
ranges by typing 
into the Name box

The Name box in Calc can be used to define new cell 
ranges by simply typing a name. The immediate 
display of a tool tip tells the user that he is about to 
create a new named cell range. 

Selects a cell area, click 
into the Name box of the 
Formula bar and enter a 
new name.

Scenario 
Protection

Users can now protect modification and deletion of 
existing scenarios. Only new scenarios can be added. 
Scenarios allow you to create a set of grouped data 
which may change depending on what parameter or 
scenario you choose from the drop-down list.

Chose Tools – Scenarios – 
Prevent changes

New menu entry 
"Sheet From File" 
in Insert menu 

You can easily insert a sheet from another file into the 
file you're currently editing via menu entry in the 
Insert menu. 

From the 'Insert' menu, 
choose 'Sheet From File'. 
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Feature Benefit How to Access

Diagonal lines for 
inside cells

More flexibility in designing spreadsheets: Diagonal 
lines can now be used within cells. This is an 
extension of the outer border lines attribute of a cell.

Choose Format – Cells – 
Borders – User-defined

Select/Deselect all 
sheets 

When multiple sheets in a spreadsheet are selected, 
it is now possible to deselect them using the 
keyboard. 

To select multiple sheets 
with keyboard, use the 
shortcuts 
CTRL+SHIFT+PAGE(UP/D
OWN). The same shortcuts 
will deselect all sheets, if 
they are all selected. 

Conditional Array 
Calculation

Array formulas, such as {=IF(A1:A3>0;"good";"bad")}, 
can now be used. A conditional array calculation is an 
array or matrix formula that includes an IF() or 
CHOOSE() function. 

Type in an array formula 
with a conditional 
calculation like 
{=IF(A1:A3>0;"yes";"no")} 
for the >0 test

Alignment of text 
larger than a cell

The horizontal alignment of a cell is now honored 
even if the text is larger than the cell width. Left-
aligned cells are expanded to the right, right-aligned 
cells are expanded to the left, centered cells are 
expanded into both directions (previously, all cells 
were expanded to the right).

Type in text in a cell, which 
is larger than the cell width. 
Change the text alignment 
(“Wrap text automatically” 
should be disabled)

Format Menu is 
easier to use

The set of menu commands on the Format menu in 
Calc remains the same for all objects to be edited. 
The structure and terminology is consistent with the 
Writer module and matches competitive applications. 

Chose Format Menu 

Cell formatting 
and deletion of 
cells leave filtered-
out cells 
untouched

When cells are filtered the following actions do not 
affect rows that are not visible due to filters:

• Deleting cell contents

• Deleting rows (deleting single cells is disabled)

• Changing cell formats including styles. 

Choose Data – Filter – 
AutoFilter, Standard Filter 
or Advanced Filter

Cell notes now 
more intuitive

Positioning and resizing of cell notes lets you have 
more control over the layout in your spreadsheets. 
Notes and their text contents can be formatted.

Choose Insert – Note, click 
the note to reposition, 
resize or reformat.

Lotus 1-2-3 import 
supporting version 
9.7

The Lotus 1-2-3 import now also loads files of Lotus 
versions up to v9.7, the file type list box lists the .123 
file name extension additionally to the already known 
.wk1 and .wks extensions. Not the full set of features 
get imported. Except of the imported features :

● Import of Integers and floating point numbers

● Numbers that are multiples of 10

● Long Numbers stored in IEEE Format

● Summation, Average functions

● Various functions like abs or sqrt

● Import of notes

● Text attributes like bold, italics or underlined

● Horizontal and vertical text alignment

Load a Lotus 1-2-3 9.7 
spreadsheet
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StarOffice Impress
StarOffice Impress module is a full-featured presentation tool, complete with many preformatted tem­
plates and a wealth of image and text effects. But what really sets it apart is its remarkable animation and 
3-D tools. So we're going to create a little two-slide presentation utilizing these and other Impress fea­
tures.

Redesigned Impress For Better Presentation Results
Enjoy increased usability, more comfortable look and feel, and much more, with the new presentation 
engine. In addition, the multi-pane view lets you keep a better overview while you design your presenta­
tion.  Compatibility with Microsoft PowerPoint has also improved.

How to access: Choose File – New – Presentation

All Custom Animations Effects And Slide Transitions From Microsoft 
PowerPoint Available
The set of custom animation effects and the slide transitions are synchronized with Microsoft Power­
Point. StarOffice 8 provides the same set with very similar names. PowerPoint users don't need any 
retraining.

How to access: Slide Show – Custom Animations

Multi Pane View
The new multi pane GUI of Impress with two more panes to the main working window makes creating 
and maintaining a slide show easier, faster, and more intuitive. A slide sorter on the left gives an over­
view of the presentation. A task pane on the right provides frequently used tools.
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More Feature Highlights

Feature Benefit How to Access

Improved Modi 
Selection

In the center task panel the following modes can be 
selected from a tab page control at the top of the 
center pane:

● The 'Normal' view for editing a single slide. It is 
shown by default.

● The 'Outline' view which gives a textual overview 
of the entire document.

● The 'Notes' view where notes to single slides can 
be written. 

● The 'Handout' view for editing the layout of the 
handout pages.

● The 'Slide Sorter'

Select tab page control in 
center pane.

Improved header 
and footer support 

New placeholders for header and footer are now 
automatically created on master pages and the user 
can customize them by using a simple dialog that is 
available from the view menu. The placeholders can 
be positioned, sized and formatted on the master 
pages. 

Choose Insert – Date/Time 
or Insert – Page number

Improved 
multimedia 
support and 
integrated Media 
Player

Impress (and all other modules including the Gallery) 
now support many more multi media formats. The 
current list of available media filters is as follows: 

AIF Audio, AU Audio, AVI, CD Audio, MIDI Audio, 
MPEG Audio, MPEG Video, Quicktime Video, Vivo 
Video, WAVE Audio

An inserted media object can be controlled with a 
new media object bar which offers “Play”,”Pause”, 
“Stop”, “Repeat”, “Mute” and “View” buttons.

Another option to preview multimedia files is to use 
the integrated MediaPlayer (Tools – Media Player), 
which can be selected from the Tools menu.

Choose Insert – Movie and 
Sound 

Improved open 
document 
behavior

Impress documents open on the first page or slide, 
regardless of the last editing position when the 
document was saved the last time. 

Open presentation.
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StarOffice Base

New Database Front-end And Engine
StarOffice has a completely redesigned database front-end tool.  StarOffice Base provides wizards to 
help you create forms, reports, queries, tables, views and relations. The forms, reports and queries are 
stored in a single file format so you can work with your database in the same way you would do in other 
popular databases.

StarOffice uses the open source, Java driven, HSQLDB database engine.

How to access: Open StarOffice Base in the Start menu. You can also start the database by double-
clicking a StarOffice Base file, or choosing File – Open or File – New in any StarOffice application.

More Feature Highlights
Feature Benefit How to Access

Table Wizard The new database table wizard helps 
create tables for your database. More than 
30 predefined table schema ensure that 
you don't forget any important aspects.

Choose File – New database

Subforms in Form 
Wizard

The Form Wizard now also provides the 
functionality to create subforms. 

Choose File – New database – 
Forms – Use Wizard to create 
form...

Improved access to 
ADO (Access/SQL 
Server) data 
sources 

The database setup displays a list of all 
existing ADO database connection. The 
user simply choose one of these 
connections to setup the database 
connection.

ADO is not available on Solaris and Linux.

Choose New database, select 
Connecting to an existing database 
and choose database type “ADO”.
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Feature Benefit How to Access

Access to various 
Address Books

StarOffice offers access to different 
external address books like 
Mozilla/Netscape, Outlook Express, 
Evolution, LDAP with read and write 
access.

If no Address Book is registered, 
choose File – Wizard – Address 
Data Source

LDAP 
Authentication has 
been enhanced 

You can now connect StarOffice to a LDAP 
server using secure sockets layer, thereby 
providing higher security when accessing 
data in StarOffice files.

See User name, Password required 
and Use secure connection in LDAP 
configuration page of the Data 
Source Administration dialog.

SQL Functions 
added 

An extended set of SQL commands (all 
numeric, string and datetime function 
specified in the SQL92 standard ) for 
dBASE, flat file and spreadsheet 
databases are now available. 

Select table in StarOffice Base, 
choose Tools – SQL...

Improved usability in 
the data source view 
and forms

Creating a new sort or filter criteria within 
the data source browser or a database 
form, the dialogs does not show an 
automatically created criteria accordantly 
the current selection.

Choose View – Data Sources – 
Autofilter/Default Filter

Forms And Form Controls
Scrollbar Form 
Control 

The new scrollbar form control can be 
embedded in all StarOffice documents 

Choose View – Toolbars – Form 
Design – Scrollbar 

Spin Button Form 
Control

The new scrollbar form control can be 
embedded in all StarOffice documents 

Choose View – Toolbars – Form 
Design – Spin Button

Improved table 
control capabilities

Text columns in table controls can now 
display and edit multi-line text.

Choose View – Toolbar – Controls, 
Insert a table control, check 
“Multiline input” option in the 
properties dialog for the text box. 

Property Browser 
Enhancements

The property browser for modifying various 
aspects of form and dialog controls, as well 
as logical forms is now easier to use. 

Choose View – Toolbars – Form 
Design – Control Properties

Properties of 
Navigation bar form 
control improved

The Navigation Bar of the database forms 
is now a separate control. It provides a 
richer set or properties and is more flexible 
as the integrated version in StarOffice 7

Open Controls Toolbar, choose 
Navigation Bar control and add it to 
the document.

Data Source 
Browser in 
embedded forms 

The data source browser in a embedded 
form document (F4) displays exactly the 
database which the form belongs to, and 
not the registered databases anymore. 

Choose File – Open – Database File 
– Forms

Form design opens 
with changed grid 
size and vertical 
ruler 

When opening a new form, the vertical 
ruler is now visible and the grid size is set 
to 5 to allow a better adjustment of a 
control. 

Choose File – Open – Database File 
– Forms

Property "Scale" The property "Scale", which was previously 
available for image controls in the Basic 
dialog editor only, is now also available for 
image controls and image buttons in forms. 

Choose File – Open – Database File 
– Forms
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3 Microsoft Office Interoperability
StarOffice 8 continues to improve on Microsoft Office import and export filters available today. StarOf­
fice 8 has improved import and export of the following Microsoft Office objects:

● Password-protected MS Word and MS Excel files

● MS PowerPoint AutoShapes

● Headers and Footers

● Tables, paragraphs and table spaces in MS Word documents

● Large MS Excel spreadsheets

● Formulas in MS Excel 

● Floating objects, page breaks and column breaks in MS Word documents 

● MS Office files in XML formats  

Importing Of Password Protected Microsoft Word And 
Excel Documents
Password-protected Microsoft Word and Microsoft Excel documents can be opened using the Microsoft 
Office 97/2000 compatible document encryption (the original password is required). 

How to access: Start to open a password-protected document and the Enter Password dialog will appear. 
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Same Set Of Shapes (AutoShapes) As Microsoft Provides
The Drawing Toolbar has been enhanced to include a rich set of new, commonly used drawing Shapes: 
Basic Shapes, Block Arrows, Symbol Shapes, Flowchart, and Stars and Banners. All shapes can be 
imported/exported to commonly known formats without data loss.

How to access: The drawing toolbar appears below the document. If it is not visible, choose View – 
Toolbars – Drawing

More Feature Highlights
Feature Benefit How to Access

Improved import of 
headers & footers 

Module: Writer

Tables and graphics in headers and footers 
are now imported more accurately.

Import a Microsoft Word 
document with a tables and 
graphics in header or footer.

Adjust positioning of 
floating screen object 

Module: Writer

The positioning of floating screen objects was 
adjusted so Writer can more accurately import 
Word documents. The adjustment affects the 
determination of the paragraph top for the 
positioning of floating screen objects.

Choose Tools – Options – 
StarOffice Writer – Compatibility 
– “Consider wrapping style 
when positioning objects”

Automatic Page And 
Column Breaks in 
tables

Module: Writer

Microsoft Word documents with tables can 
more accurately be imported/exported to and 
from StarOffice Writer.

Open the Table dialog, choose 
Text Flow tab page.

Import and export of 
spin buttons and 
scrollbars 

Module: Writer & 
Calc

Now it's possible to import Microsoft Office 95 
and Office 97 spin buttons and scrollbars. All 
spin buttons and scrollbars are exported as 
Microsoft Office 95 controls. 

Import a Microsoft Office 95/97 
document with a spin button 
control

Import/Export of 
Microsoft 
Spreadsheetml and 
WordML documents

An import and export filter for the Microsoft's 
XML formats SpreadsheetML and WordML is 
available

Load and Save documents in 
the WordML or SpreadsheetML 
format.

Vertical alignment 
'Line of text' 

Module: Writer

Vertical alignment at line has been introduced 
for text frames which are now anchored to a 
character. 

After you have inserted a frame 
(Insert – Frame) and anchored it 
to a character, choose Format – 
Frame – Type, under 'Position' 
the selection list for the vertical 
alignment includes 'Line of text'.
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Feature Benefit How to Access

Table borders styles 
can be merged

Module: Writer

This feature merges two different border 
styles of adjacent cells in a Writer table into 
one border style.

Choose Format – Table – 
Borders. There is a checkbox 
'Merge adjacent line styles' on 
the property area.

Font-independent line 
spacing

Module: Impress

Line spacing of StarOffice Impress no longer 
depends on the font

Microsoft PowerPoint 
presentation get imported more 
accurately 

Enhanced page 
scaling for printing

Module: Calc

Specify the number of horizontal and vertical 
pages for printing just like in Microsoft Excel. 

Choose Format – Page – Sheet 
– Scaling mode:
“Fit print range(s) to 
width/height” and select the 
width and height in pages.

Cell attributes "Shrink 
to fit cell size" and 
horizontal alignment 
"Filled"

Module: Calc

Cell content is shown shrunk or repeated to 
the cell size.

Choose Format – Cells – 
Alignment

Improved Excel 
export formula 
compiler

Module: Calc

The formula compiler in the Excel export filter 
has been re-implemented to improve the 
export capabilities. 

Load and save Microsoft Excel 
spreadsheets with complex 
formulas.

Paragraph Spacing to 
Table Borders 

Module: Writer

Paragraph and table spacing are now added 
instead of only considering the distance to the 
border set in the table's properties. This new 
feature improves the Microsoft interoperability 
and is also set as default for newly created 
Writer documents.

Load a Microsoft Word 
document with a text table

Improved repeat 
table heading

Module: Writer

For better compatibility more than one row 
could be repeated in table cells.

Choose Table – Table 
properties – Text flow – Repeat 
heading

Chapter 3   Microsoft Office Interoperability  27



28   StarOffice 8 Guide to New Features



4 Installation and Configuration
StarOffice 8 introduces a host of new features to ease installation and user administration.  StarOffice 
now follows the installation procedures of the operating system.  StarOffice user settings are now config­
ured using a tool originally introduced in the Java Desktop System (JDS). The Java Desktop System 
Configuration Manager helps to manage StarOffice user configuration data, such as profiles and security 
settings. In addition, multi-language installation is significantly easier with StarOffice 8 as the users can 
decide what language(s) they want to use at install time, rather than re-installing a separate language pack 
after installation of the core StarOffice product.    

Native Installation Support
The StarOffice setup and installation is now based on the most common installation type provided on the 
respective operating systems. These are 'pkg' packages on Solaris, 'rpm' packages on Linux, and 'MSI' 
packages on Windows.

How to access: Start the setup or use the pkgadd or rpm installers for a silent installation

Multi-language Installation
During StarOffice setup the user can select which languages should be installed. The user can switch 
between these languages.

How to access: Tools – Options – Language settings – User Interface

Central Configuration Tool (Enterprise Edition only)
The JDS Configuration Manager is the solution for central management of StarOffice configuration set­
tings. With this tool it is possible to view, define, and enforce StarOffice configuration settings on dif­
ferent levels of an organization's hierarchy (such as organization, group or user level). These settings 
('policies') are stored in a central configuration repository (usually an existing enterprise LDAP server). 
This way an administrator can prevent unsophisticated StarOffice users from reconfiguring a system, 
violating security policies, repositioning icons, etc.

The JDS Configuration Manager is part of the StarOffice Enterprise Edition (the Enterprise Edition is 
available from Sun sales, please visit www.sun.com/sales for more information) and replaces the Star-
OfficeTM Configuration Manager (SCM) of StarOffice 7, adding the following new features:

● Improved User Interface: The user interface is completely redesigned. It provides a better overview 
of  all configuration items and offers simpler interaction with the user. 

● Performance and Scalability Improvements: A local registry and incremental updates offer a much 
better performance during startup and runtime.

● Profiles: With profiles it is possible to group and organize settings. The profiles can be reused for 
different parts of your organization or individual users.
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● Reports: Reports allow you to display a summary of resulting settings. It's possible to store or print 
out these reports for archive purposes.

More Feature Highlights
Feature Benefit How to Access

Simpler User 
Installation

The new installation mechanism allows a quicker 
and simpler workgroup or company-wide 
installation. StarOffice silently creates the user 
specific configuration at the very first start of 
StarOffice. 

Start StarOffice for the first 
time

CUPS Integration StarOffice on Linux provides easier printer 
selection, network printer browsing and PS printer 
description. 

Only available on Linux

Language packs Now language packs can be installed to enhance 
an already installed StarOffice version. You no 
longer need to install a complete office suite to 
get an additional language. User can switch 
between the installed languages 

The setup of Language 
Pack installs the language 
automatically.

Display of read-only 
configuration 
elements

The StarOffice Configuration could be setup as write 
protected configuration items. These properties 
cannot be changed by the user. The configuration 
dialogs of StarOffice displays such items grayed out 
and with an additional padlock item. 

Setup an Configuration item 
as protected and open the 
Options dialog. All 
protected configuration 
items are grayed out.

Automatic Java 
Configuration

The user can determine and maintain the Java 
environment of StarOffice. StarOffice typically 
uses the existing Java environment of the system. 
StarOffice installs a Java environment if an 
appropriated does not exists. 

Tools – Options – 
StarOffice – Java. 

You do not have to select a 
version of Java manually as 
it will be done automatically. 
If the user switches Java 
off, then all other related 
settings will be disabled. 
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5 Developer-Specific Features
StarOffice 8 builds on the strong developer offering in StarOffice 7 by adding two more programming 
languages, providing the capability to write macros in other languages (in addition to StarOffice Basic) 
and by enhancing the SDK and StarOffice Basic debugger. In addition, Developers get improved MS 
Office compatibility by being able to import Microsoft Office VBA dialogs.

Support For Additional Macro Languages Added By 
Scripting Framework
StarOffice can be automated by scripting the StarOffice API in Java, JavaScriptTM and Beanshell as well 
as StarOffice Basic. Macros written in Java can be developed in and deployed from NetBeansTM. Editors 
for JavaScript and BeanShell, as well as the StarOffice Basic integrated development, ship with StarOf­
fice.

The framework could be extended by other programming languages. The OpenOffice.org community, for 
example, is currently working on a solution for Python. Users can assign code to menu items, keyboard 
shortcuts, application and document events, form controls within documents and various objects within 
documents. 

Programmatic Control Of Menu And Toolbar Items
Developers can adapt menu bar and toolbar layouts to their needs. Menus, pop up menus and toolbars are 
accessible via the API. They can be inserted, removed or modified at runtime in StarOffice.

Basic IDE Macro Chooser And Macro Organizer
The Scripting Framework allows the user to develop macros in languages other than StarOffice Basic. 
The Macro Organizer helps to manage the macros. Users will find access to the various dialogs for 
Macro management via Tools – Macros submenu. 
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More Feature Highlights
Feature Benefit How to Access

New Package Manager The Package Manager is a tool to import, 
export and remove packages, i.e. extensions 
to the StarOffice installation. An extension can 
be a document with a script or an Universal 
Network Object (UNO) component. 

Choose Tools – Package 
Manager

The dialog shows all available 
packages, related to the 
context in which they reside, 
e.g. the User Installation, the 
Office Installation layer, or 
open documents. 

Please also see “unopkg -h” 
via command line.

SDK Improvements Transparent Use of UNO Components from 
C++ and Java  The UNO component context 
is provided in a more transparent way. From 
the perspective of the client code there is no 
difference between local and remote 
components.

Javamaker generates .class instead of .java 
files  The javamaker tool (generating Java 
classes for UNOIDL entities) now directly 
generates Java .class files, instead of .java 
source files. 

Office Bean  With the OfficeBean, a 
developer can easily write Java applications, 
harnessing the power of StarOffice. It 
encapsulates a connection to a locally running 
StarOffice process, and hides the complexity 
of establishing and maintaining that 
connection from the developer.

Increases Usability of UNO  UNO now 
supports multiple-inheritance interface types. 
The “queryInterface” call is no longer required 
for those new interfaces. Code can be 
generated for the new single interface based 
services i.e. constructors.

The SDK is available in the 
StarOffice Enterprise Edition

Import of VBA dialogs Microsoft Office documents with attached VBA 
dialogs get imported as StarOffice Dialogs. 
These dialogs can be used by the Scripting 
Framework programming language.

Load a Microsoft Office 
document with a VBA dialog

Choose Tools – Macros – 
Organize Dialogs

Improved Basic 
Debugger with 
Property Browser

The debugger for StarOffice Basic now has a 
property browser, which offers the ability to 
display the type list of available properties with 
the values at the runtime of the Macro.

Tools – Macros – Organize 
Macros – StarOffice Basic -> 
Debugger

Redesign of how to 
bind macros and 
events

The Events tab page of the Customize dialog 
has been improved to make it easier for users 
to create event bindings.

Choose Tools – Customize – 
Events

32   StarOffice 8 Guide to New Features



6 Internationalization Features
StarOffice 8 adds a number of features to improve installation, usability and readability across the global 
languages supported by StarOffice. Installation of individual, modular language packs makes it much 
easier for the user to switch between languages.

Note that StarOffice in Asian languages (Simplified Chinese, Traditional Chinese, Japanese, and Korean, 
also referred to as CJK) is known as StarSuiteTM. 

Translator For Simplified To Traditional Chinese And 
Vice Versa
Easily transfer Chinese written text between simplified Chinese and traditional Chinese characters. Sim­
ilar to the translation or conversion that happens between Japanese Hiragana/Katakana and Korean 
Hangul/Hanja.

How to access: Choose Tools – Language. This feature is only available when CJK support under “Tools 
– Options – Language Settings – Languages” is turned on. Otherwise the entry will remain hidden. 

Language Packs
Now language packs can be installed to enhance an already installed StarOffice version. You no longer 
need to install a complete office suite for each language. User can switch in between the installed lan­
guages 

More Feature Highlights
Feature Benefit How to Access

New locale data in 
language list box

New locale data for:

Malaysian, Bulgarian, Interlingua, Serbian Latin, 
Serbian Cyrillic, Croatian, Bosnian, Mongolian, 
Azerbaijani, Galician, Dhivehi, Northern Sotho, 
Gaelic, Bengali (Bangladesh), Occitan, Khmer, 
North Korea: Korean (DPRK), South Korea: 
(RoK), Lithuanian (Lithuania) and several more

Choose Tools – Options – 
Language Settings – 
Languages 

Numbering extended 
for Chinese 
simplified and 
Japanese 

The detection of numbering is now able to 
detect Chinese periods (0x3002) and Brackets 
(0xff08 and 0xff09 used in Chinese simpl. and 
Japanese) and for Japanese the space (0x3000) 
, numerals (0xff10 ...0xff19) and period (0xff0e) 

Format – AutoFormat
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Feature Benefit How to Access

Enhanced Character 
Spacing

In Japanese glyphs are often aligned in grids. 
Most Japanese users do not assign a full grid 
box to a punctuation mark such as a '.' or the 
like but have them attached to their preceding 
character.

In StarSuite this (already existing) functionality 
will be enhanced to allow the user to define 
manually a list of characters that will be attached 
to their preceding character instead of just 
having a fixed set of characters.

In Japanese version only

Right-to-left 
spreadsheet layout

Spreadsheets can be switched to right-to-left 
layout, where column A is right.

Format – Sheet – Right-To-
Left, when CTL support is 
enabled in the options dialog.
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7 System Requirements
Below are the system requirements for the StarOffice 8 Beta:

Microsoft Windows
● MS 98, ME, 2000 (Service Pack 2 or higher) or XP 

(Please note the discontinuation of support of Windows NT)
● Pentium compatible PC
● 128 Mbytes RAM
● 250 Mbytes available hard disk space
● 800 x 600 or higher resolution graphic device with 256 colors

Solaris Operating Environment: SPARC Platform Edition
● Solaris 8 OS or higher. Solaris 9 is recommended
● 128 Mbytes RAM
● 400 Mbytes available hard disk space
● X-Server with 800 x 600 or higher resolution with 256 colors
● Gnome 2.0 or higher required for support of assistive technology tools 

Solaris Operating Environment: X86 Platform Edition
● Solaris 8 OS or higher. Solaris 9 is recommended
● 128 Mbytes RAM
● 400 Mbytes available hard disk space
● X-Server with 800 x 600 or higher resolution with 256 colors
● Gnome 2.0 or higher required for support of assistive technology tools 

Linux
● Linux kernel version 2.2.13 or higher glibc2 version 2.2.0 or higher
● Pentium compatible PC
● 128 Mbytes RAM
● 350 Mbytes available hard disk space
● X-Server with 800 x 600 or higher resolution with 256 colors
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